VMware Zimbra

Zimbra Collaboration Server 7.0.1
Network Edition Release Notes

These release notes describe the new features and enhancements that are available in the ZCS 7.0.1 Network Edition release. Review the Known Issues section for a list of outstanding issues in this release before installing or upgrading.

The following sections are included in the release notes:

- Major New Features Enhancements and Bug Fixes for 7.0 on page 1
- Enhancements for 7.0.1 on page 8
- Major Fixes in 7.0 Releases on page 9
- More About ZCS 7.0 Features on page 15
- Beta Features in ZCS 7.0 on page 17
- Upgrade Process on page 18
- Before you Upgrade on page 18
- Upgrade Instructions on page 20
- Status of Your Customizations to ZCS after Upgrade on page 23
- Future Changes to ZCS on page 18
- Known Issues on page 24
- Product Documentation on page 26
- Bug Reporting on page 26

Major New Features Enhancements and Bug Fixes for 7.0

ZCS Administration

- Added admin console configuration control of the data source polling interval. Polling intervals can be set for POP, IMAP, Calendar, GAL, RSS, and CalDAV. This can be set from the account/COS Advanced tab. By default the polling intervals are not enabled. (Bug 21199)
• ZCS now integrated with ClueBringer PolicyD (cbpolicyd). This is packaged as part of the zimbra-mta package and configured to run as a daemon on 127.0.0.1:10031. It is integrated with Postfix as a check_policy_service. The cbpolicyd data base uses sqlite. The default configuration enables quotas module. See Postfix Policyd. (Bug 8791)

• Added additional Postfix configuration parameters to localconfig. Defaults are equivalent to the Postfix defaults. Changing these values via localconfig allows local admins to customize these settings to fit their environment and maintain their settings through upgrades. See Postfix documentation for details on the impact of changes to their attributes. (Bug 33811) The localconfig keys for Postfix configuration that can be customized and preserved are
  • postfix_delay_warning_time=0h
  • postfix_bounce_notice_recipient=postmaster
  • postfix_notify_classes=resource,software

• UI change. Domain list-view and left panel navigation now displays configured alias domains. Domain list-view adds a configuration wizard “Add a Domain Alias”. (Bug 11009)

• A virus quarantine mailbox is automatically created during an installation or upgrade of ZCS. When AmavisD identifies an email message with a virus, the email is automatically sent to this mailbox. The virus quarantine mailbox is configured to delete messages older than 7 days. (Bug 11061)

• Added admin console configuration control of the zimbraPrefAutoSaveDraftInterval setting. Administrators can customize the autosave interval for draft messages. This can be set from the Account/ COS Preference tab. The default value is 30 seconds. (Bug 25447, 52326)

• Administrators can define which users are authorized to send messages to a distribution list. The default is all users can send to all distribution lists. The Milter Server needs to be enabled via the server MTA tab in the administration console to restrict access. (Bug 9620, 46311, 50348)

• Advanced Search in the admin console now includes the ability to search for a Class of Service. (Bug 18791)

• New account migration tool has replaced Bulk Provisioning in the administration console. The Migration Wizard in the admin console can be used to create one-step Exchange Migration xml template, to provision accounts and to import data. The new email migration wizard is based on IMAP datasource code. There is support for split-domain setups and differentiation between local and remote accounts (zimbraMailTransport). (Bugs 44981, 50343, 50522, 51360, 16995)

• Any of the amavis attributes defined in the amavis schema can be applied to a domain. This allows for per domain level white/black lists, scoring and tagging levels and spam check bypass. (Bug 32557)
• CLI support for per-domain SSL Certificates. This is implemented and supported only through the use of reverse proxy (NGINX). In the admin console, the SSL certificate input and key pairs are pasted in the Domain>Certificates tab. **zimbraVirtualHostname** and **zimbraVirtualIPAddress** must be defined on the domain for this to work. **zmprov getAllReverseProxyDomain (garpd)** can be used to return a list of domains with SSL certificates properly configured. This requires that customers add IP aliases for each **zimbraVirtualIPAddress** on their reverse proxy. (Bug 8128)

• New license attributes give administrators visibility into the number of mailboxes that can be enabled for licensed features and the ability to enable and disable these features by Class of Service. See License Activation for 7.0 on page 19. (Bug 20984)

ZCS Server

• CJK Analyzer is now used for text tokenization in indexing CJK unicode blocks. StandardTokenizer logic is used for the other blocks. (Bug 45280)

• ZWC (running in IE 6.0 or later, Firefox 3.0 or later, Chrome, Safari, ) now supports SPNEGO negotiation and Kerberos single sign-on in a Microsoft Active Directory environment. IMPORTANT: If you enable the SPNEGO SSO feature on a domain, you must instruct all users to configure their browsers properly. Improperly configured browsers will behave differently depending on the browser. Documentation about how to configure SPNEGO is in the ZCS Administrator’s Guide, Appendix C. (Bug 6062, 52050)

• OAuth support has been added. Refer to /opt/zimbra/extensions-extra/oauth/README.txt for detail integration procedures. (Bug 45781)

• How mailboxes handle messages when the quota is reached can now be controlled at the account or COS level using the **zimbraMailAllowReceiveButNotSendWhenOverQuota** attribute. When set to TRUE, a mailbox that exceeds its quota is still allowed to receive new mail and calendar invites. When the value is FALSE (default value), quota checking is done as before. Quota bypass is only implemented for messages. All other mail items are still affected by the quota, even when this attribute is set to TRUE. (Bug 15666)

• ZCS Backup has improved how out-of-disk space errors are handled when backing up ZCS. Admins get an email message that describes the error and which backup failed. (Bug 16482)

• ZCS Backups can be configured to run **mysqldump** to backup the MySQL database during backup sessions. When this is enabled, a mysqldump backup runs with each full, incremental and auto-grouped backup. The MySQL dump files are gzipped and placed in the backup target directory. (Bug 17424)
• When upgrading to ZCS 7.0, the mailboxd_java_heap_size property is set according to the mailboxd_java_heap_memory_percent property. (Bug 43140)

• Calendar resources defined in external LDAP/AD are now supported (Bug 42828)

• For IMAP/POP3 zimbraReverseProxyUseExternalRoute can be set per domain. (Bug 42866)

• HTML mail is supported on Windows Mobile 6 and Android email client. Note: In line attachments do not display correctly for droid. This is a third party issue. (Bug 18608)

• Single Sign On support using TriCipher has been added. Refer to /opt/zimbra/extensions-network-extra/tricipher/README.txt for detail integration procedures. (Bug 50682)

• All Zimbra server and storage components, including LDAP, MTA, Proxy, and Mailbox, are supported on NFS data stores in VMware vSphere 4.x. (Bug 50635)

• zimbraWebClientLoginURL and zimbraWebClientLogoutURL can be disabled based on browser and platform (Bug 52050)

• The DEBUG logging level has been removed and is replaced by TRACE logging. Protocol trace is available in the following logging categories with TRACE logging: zimbra.smtp, zimbra.lmtp, zimbra.soap, zimbra.imap, zimbra.imap-client, zimbra.pop, zimbra.pop-client. (Bug 52501)

Zimbra Web Client

• A new ZWC theme called Carbon has been designed and is now the default theme for new installations of ZCS. This theme displays the VMware Zimbra logo. (Bug 51907)

  Note: The other themes display the Zimbra logo. The layout for the themes has been updated to move the user’s name to the top right of the page.

• The account quota information has been moved. The quota is displayed as a tool tip on the user’s name. (Bug 52873)

• In ZCS 7.0, the Documents application has been removed. Notebooks and pages in Documents are migrated to Briefcase after ZCS is upgraded. The folder structure and file names do not change. The migration preserves all the revision history if it was available, including the revision date and user information. (Bug 39647) (Bug 50465)

• ZWC users will see names in the address fields in messages displayed in an” email bubble” rather than as text. The bubble option is on by default in ZCS 7.0. Users can turn this off in their Preferences > General page. (Bug 52509)
• When autocomplete is used to select a distribution list the DL address includes an “expand” link. Users can view the addresses in the list and select individual addresses or the DL. This feature is enabled by default. (Bug 7554).

• When the Bubble option is enabled, when autocomplete is used to select a distribution list, the address bubble added to the message includes a + (plus) sign to identify the address as a distribution list. Users can click the + to see to expand the list to see who is in the DL. (Bug 52113)

• Filters can now be created for outgoing messages. (Bug 50541, 10778)

• A To or Cc filter condition is added to Mail Filters (Bug 6719, 49895)

• The Trash folder is available for each application (email, calendar, tasks, etc). Only items specific to the selected application are displayed in the Trash folder when Trash is open in the application. Note: When users select Empty Trash, items from all applications are removed. (Bug 28131)

• Users can now recover email messages that have been deleted or emptied from their email Trash folders. Users right-click on the Trash folder and select Recover Deleted Items. This can be enabled from the administration console Account/COS features tab. When enabled, the attribute zimbraDumpsterEnabled is set to TRUE. (Bug 30582, 45284)

• Deleting a recurring appointment displays a prompt and confirmation asking if you want to delete the instance or the series or recurring items. (Bug 36999)

• Mail folders in an expanded or collapsed state persist across browser restart, login, logout, etc. (Bug 1920)

• Tasks and appointments have an optional popup, email reminder that can be enabled to alert the user of the event. (Bug 10287 and 15827; UI change).

• ZWC users can now configure an email address where reminders for Tasks and Calendar appointments are sent. This setting is on the Preferences>Notifications page. (Bug 10287)

• Mail and Contacts actions can be undone using the “undo” dialog that displays when an action is performed. (Bug 4819)

• Ability to add multiple attachments to an email message using Ctrl and Shift. (Bug 7561)

• Ability to create an appointment similar to an existing appointment by right-clicking on the existing appointment and selecting Create a Copy. (Bug 15120)

• Users can forward one or more contacts. (Bug 3905 and 47655)
• The font size to use when printing an email message can be configured from the Preferences tab. The Font Size link has been removed from the file print view. (Bug 42260)

• The Add Attachment dialog now includes tabs for mail, contact, and briefcase files. (Bug 31663)

• Calendar appointments can be saved locally without sending the invitation to the attendees. (Bug 7325)

• Briefcase now supports versioning and check in/out capabilities. Users can revert to an older version of a file or document. (Bug 23816)

• Briefcase files can be checked out and locked so that users cannot overwrite each others work. (Bug 43260)

• Files in Briefcase can be renamed. (Bug 31792)

• Tasks now open as a tab, similar to Compose tab in Mail. User can quickly switch between Task and other parts of the application. (Bug 37828)

• New appointments in Calendars now open as a tab. User can quickly switch between an appointment they are creating and other parts of the application. (Bug 37827)

• Standard Web Client. User can automatically save drafts of messages while composing. (Bug 22007)

• Standard Web Client. Reading pane view options enhanced in HTML client to view right or bottom. (Bug 37042)

• Date range view enhancement in Calendar. (Bug 32898)

• Ability to migrate data from Public Folders. (Bug 24300)

• Users can now select to send a message at a later time. They configure a date and time to send an email message and it is saved to the Draft folder until it is sent. This feature is enabled from the admin console, COS or Account Feature tab. (Bug 7524, 51673)

• LinkedIn Zimlet allows the user to invite someone into their network or ability to view a summary of their profile. (Bug 29908)

• HTML editor has additional font families in HTML client composing option. (Bug 40026)

• Extended color selector including tag color menu, folder properties dialog, preferences, and admin console. (Bug 14962)

• User signatures can now be set by account and users can set a different signature in an email message and they can choose a contact to be attached as a vCard when a particular signature is used. (Bug 49180)

• Ability to send email to a meeting organizer and all attendees. (Bug 36106)

• When an organizer changes an appointment, attendees see the changes highlighted in a different color in the invite. (Bug 49976)
• Appointment invites, updates, cancellations, etc received by ZCS as TNEF from Outlook or Exchange now work like their ZCS generated equivalent. (Bug 48087 and 32651)

• New Trusted Addresses preferences page lets users create a list of trusted addresses or domains so that images sent in emails from those addresses are automatically displayed in their email message. (Bug 14823)

• A Find Shares link has been added to the Folders section in the Overview pane. This makes it easier for users to find items that are shared with them. (Bug 46699)

• The folder on the tool bar now reads Report Spam and other reference to Junk were changed to Spam. The Junk folder in the Overview pane is the same. (Bug 50421)

• In Calendar preferences, users can customize their work week and hours worked schedule. (Bug 4714)

• User’s scheduled work hours as defined in the user’s Work week and hours Calendar preferences are highlighted in the user’s calendars and shown in the calendar new appointment Scheduler view. (Bug 15427, 43469)

• Scheduling appointments with one or more attendees and reserving one or more conference rooms has been improved. (Bug 42232, 52307)

• Overall improvements to the Calendar UI for meeting invitations. One of the changes is when a meeting invite is received, the invitee can see the invite along with their calendar for the day in their Inbox. (Bug 47112)

• The following new Zimlets are included as standard in ZWC: Social, Search Highlighter and WebEx. (Bug 48404)

• A new search options called People Search lets users search the GAL for people within their organization and see detailed information including phone numbers, office location and the contact’s photo. This feature is enabled from the Account/COS Features tab. When enabled, the attribute, zimbraFeaturePeopleSearchEnabled is set to TRUE. (Bug 50319, 48472, 48486, 51055)

• If the browser is IE6, when users log in the login page defaults to the Standard (HTML) client, for a better user experience with ZWC. Users can change this. Note: IE 6.0 is no longer supported in the Advanced Web Client. (Bug 51326)

• The ZWC Help can now be easily updated to replace the references to “Zimbra”, “Zimbra Web Client”, “ZWC”, Zimbra Collaboration Server”, and “ZCS” with customer’s rebranding references. (Bug 12937)

Zimbra Connector for Microsoft Outlook (ZCO)

• ZCO .msi installer is now localized. (Bug 12045)

• ZCO can be rebranded to change the company name and product name. The logo can be replaced. (Bug 15993)
- ZCO can be configured to automatically prompt users to install a ZCO upgraded version. (Bug 9928)
- Microsoft Outlook 2010 (64 bit) is now supported. (Bug 43685)
- ZCO. Support for migrating a ZDB profile from one machine to another machine. (Bug 28136)
- ZCO synchronizes signatures from Outlook and the Zimbra Web Client accounts. (Bug 15376)
- ZCO. User defined contact fields can be synced to and from ZCS. (Bug 50703)
- ZCO. Check for Update is now under the Help tab. (Bug 52866)
- ZCO. A Zimbra account can now been combined with POP, IMAP or Exchange accounts within a common Outlook profile. Within these profiles the Zimbra account does not have to provide the default store, although clearly this will affect the extent to which you can use current ZCO functionality. See More About ZCS 7.0 Features on page 15 (Bug 12518)

Enhancements for 7.0.1

- Free/busy for Exchange 2010 support has been added. Administrators can use the zmprov CLI to configure which Exchange Free Busy provider the server will use:
  - EWS-based (Exchange Web Service) for Exchange 2010

The globalConfig/server attribute is `zimbraFreeBusyExchangeServerType`. The default value is `webdav`. Set `ews`, to support free/busy with Exchange 2010.

(Bug 56667, 42385, 43558)

System Updates for 7.0

New Platforms (for Network Edition):
- Ubuntu 10.04 LTS (64-bit)
- Red Hat® Enterprise Linux®, AS/ES 6 (64-bit, mid-version) (BETA)

Deprecated Platforms (for Network Edition):
- Red Hat Enterprise Linux 4 (32-bit) (64-bit)
- Red Hat Enterprise Linux 5 (32-bit)
- SUSE Linux Enterprise Server 10 (32-bit)
- Ubuntu 8.04 LTS (32-bit)

Note: Deprecated platforms will EOL after ZCS 7.0
End-Of-Life Platforms (for Network Edition)

• Ubuntu 6.06 LT (32- and 64-bit)
• Mac OS X 10.4 Tiger (32-bit)

Note: End-of-Life platforms are not available for ZCS 7.0 and will not be available in the future.

Browser Support (Zimbra Web Client):

• Internet Explorer 6.0 is no longer supported in Advanced Web Client and only supported in Standard Web Client.

Major Fixes in 7.0 Releases
### Major Issues Fixed for 7.0.1

<table>
<thead>
<tr>
<th>ID</th>
<th>Issue Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21291</td>
<td><strong>UI change.</strong> When viewing conversation in ZWC, users can now use right and left arrows keys to open and close a conversation view.</td>
</tr>
<tr>
<td>55415</td>
<td><strong>UI change.</strong> The following improvements were made with using the “bubbles” in ZWC email address fields:</td>
</tr>
<tr>
<td>55460</td>
<td>• When addressing an email, users can right-click on an address bubble to display a menu of options, including Delete, Edit, Edit Contact and other options.</td>
</tr>
<tr>
<td>55777</td>
<td>• When users receive an email message, they can right-click on an address bubble to display a menu of options, including Add to Contacts, New Email, Advanced Search and other options.</td>
</tr>
<tr>
<td></td>
<td>• When addressing an email, users can left-click and drag and drop address bubbles to another address field. CTRL+C and CTRL+V also work to move address bubbles.</td>
</tr>
<tr>
<td></td>
<td>• Users can tab between addresses bubbles.</td>
</tr>
<tr>
<td></td>
<td>• Semicolon is not necessary when displaying addresses in the bubble.</td>
</tr>
<tr>
<td>52834</td>
<td><strong>UI change.</strong> The Preferences&gt;Mail&gt;Check for new mail every...now includes the options to check Manually and As new mail arrives. To display the option As new mail arrives, zimbraFeatureInstantNotify must be set to TRUE.</td>
</tr>
<tr>
<td>56077</td>
<td><strong>UI change.</strong> A new right-click option is available when browsing folders, reading messages or when looking at addresses in Address Book to find emails</td>
</tr>
<tr>
<td>56086</td>
<td>• When browsing folders, right-click a message to find emails received from or sent to sender(s).</td>
</tr>
<tr>
<td></td>
<td>• When reading a message, right-click an address to find emails received from and sent to recipient.</td>
</tr>
<tr>
<td></td>
<td>• When viewing contacts in the address book, right-click an address to find emails received from or sent to the contact address.</td>
</tr>
<tr>
<td>56081</td>
<td><strong>UI change.</strong> Users can search their Sent Folder for emails sent to specific recipients. When users are in their Sent folder, they can select one or more message, click the To header and the Find Email To Recipients dialog is populated with the email addresses (To, Cc, Bcc). The search is an AND search. Only messages that include all the recipient addresses are included in the search results.</td>
</tr>
<tr>
<td>54806</td>
<td><strong>UI change.</strong> In Calendar, the ability to mark an appointment as private is now on the appointment page in the Display area.</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Type</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
</tr>
<tr>
<td>55831</td>
<td>UI change</td>
</tr>
<tr>
<td>40184</td>
<td>UI change</td>
</tr>
<tr>
<td>54188</td>
<td></td>
</tr>
<tr>
<td>43271</td>
<td></td>
</tr>
<tr>
<td>55711</td>
<td></td>
</tr>
<tr>
<td>56757</td>
<td></td>
</tr>
<tr>
<td>57551</td>
<td></td>
</tr>
<tr>
<td>57204</td>
<td></td>
</tr>
<tr>
<td>57491</td>
<td></td>
</tr>
<tr>
<td>57500</td>
<td></td>
</tr>
</tbody>
</table>

### Major Issues Fixed for 7.0

To see a list of all the changes for this release, see the [Zimbra Product Portal](http://pm.zimbra.com/pm_release.php?rel=7.0&prod=zcs)
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>44202</td>
<td>Mailbox.log files are now compressed</td>
</tr>
<tr>
<td>9141</td>
<td>UI change. In Conversation view, the sender list can now hold up to the last 8 participants. The earliest message’s author may not be displayed if more than 8 participants in the conversation thread.</td>
</tr>
<tr>
<td>43265</td>
<td>Resolved out of memory issue caused by cross-mailbox search</td>
</tr>
<tr>
<td>24096</td>
<td>IMAP performance improvements</td>
</tr>
</tbody>
</table>
| 50274 | The DEBUG setting is no longer enabled for conf/log4j.properties.in. The default log level for the following categories was changed from DEBUG to INFO  
  - zimbra.sync  
  - zimbra.wbxml  
  The log level for individual user can be set differently through account logger for the above categories. Following are the examples:  
    - zmprov aal user@domain.com zimbra.sync debug  
    - zmprov aal user2@domain.com zimbra.wbxml debug  
  To remove the custom logger from the account, use the following commands:  
    - zmprov ral user2@domain.com zimbra.wbxml debug  
    - zmprov ral user2@domain.com zimbra.wbxml debug |
| 20984 | All network edition installs now require license activation. New installs will have a 10-day grace period from the license issue date before requiring activation. Upgraded ZCS versions require an immediate activation to maintain network feature functionality. We will provide a means of creating manual activations for systems that do not have external access to the Zimbra license servers. License 2.0 now includes additional attributes for licensed features, as well as one additional license type, perpetual. |
| 19107 | Added the ability to search for aliases by full or subset of alias name or domain. |
ZCO. Previously any client process using ZCO’s service providers would trigger sync (between ZCS and ZCO’s local ZDB store) unless the process was explicitly excluded using the SyncDisabledProcesses registry setting or was one of a handful of hard-coded exclusions -

- SEARCHPROTOCOLHOST.EXE
- DLLHOST.EXE
- ACRORD32.EXE
- ACROBAT.EXE
- MYOB.EXE
- MYOBP.EXE

This logic has now been reversed so that by default only the following processes trigger sync -

- OUTLOOK.EXE
- BLACKBERRYAGENT.EXE
- BLACKBERRYMAILSTORESERVER.EXE
- DESKTOPMGR.EXE  // BB cradle sync
- WCESMGR.EXE     // ActiveSync
- WMDHOST.EXE     // Windows Mobile Device Center
- BBMGRW32.EXE    // BES 4 manager

A new SyncEnabledProcesses registry setting (under Software\Zimbra) can be used to enable sync for additional processes.

The existing SyncDisabledProcesses setting has been retained to allow sync to be blocked for any of the 7 processes on the default list above.

In both cases the setting should consist of a list of process names (including .exe) separated by semicolons.

---

Third-party issue. The minimum kernel version for Red Hat Enterprise Linux Server release 6.0 is 2.6.32-71.14.1.el6.x86_64

Third-party issue. RHEL4 update 2 and RHEL4, update 3 have a bug in the kernel that limits the file descriptors given to the Zimbra user at boot time.

The workaround for this is to run RHEL4 update 4 or later.

zmconfigd will fail to detect configuration changes on servers that are not running mailboxd. These servers will need to be restarted for configuration changes in LDAP to be written to the Zimbra configuration files. Type as:

/opt/zimbra/bin/zmconfigdctl restart
Third-party issue. Firebug add-ons installed on Firefox can cause the admin console to hang when editing an account. Firebug should be disabled if you experience this problem.

When ZCS upgraded to MySQL 5.1, the binlog_format for MySQL 5.1 was explicitly set to MIXED.

Localconfig key ldap_starttls_required was added. Values: TRUE (the default), FALSE. It controls whether the java ldap client will use starttls when it establishes connections to Zimbra LDAP server.

*Note:* In addition to the new ldap_starttls_required, the other two legacy LCkeys (ldap_starttls_supported and zimbra_require_interprocess_security) must still be set to "1" in order for starttls to be used.

ZCS Backup. The following options were added for the zmschedulebackup command: mail-report, zipStore, include/exclude Blobs, include/exclude Hsm Blogs, include/exclude SearchIndex, sync, server. Removed the -u option.

Service startup times have been reduced by 80% by streamlining the configuration process.

The JavaMail implementation for SMTP client has been changed to one that Zimbra developed. To use the JavaMail default SMTP client, set the LC key javamail_zsmtp to FALSE.

The standard JavaMail MIME parser as been changed to one that Zimbra developed. To use the JavaMail default MIME parser, set the LCkey javamail_zparser to FALSE.

The organizer of an appointment will see an INVITE_OUT_OF_DATE exception when saving changes to an appointment if the item has bee updated on the server, such as the state of the appointment has been changed by an attendee’s reply email while the organizer is in the appointment composer window before clicking Save.

Schedule information is shown in-line and no longer under a Schedule tab. Clicking the "send" button sends invitation updates, while clicking the "save" button only saves the appointment and does not send an updated invitation.

Resolved issue of losing focus when composing a message, while receiving a message, and sound alert is enabled. Workaround requires using html5 audio tag instead of the html5 embed tag, which is used in newer versions of Firefox.
More About ZCS 7.0 Features

The following section gives additional information about some of the new features and changes in ZCS 7.0

Migration of Notebooks to Briefcase

In ZCS 7.0, the Notebook application has been removed. When users log into their accounts for the first time or receive an email message after the upgrade to ZCS 7.0, their Notebook folders and pages are migrated to folders in their Briefcase application.

The folder structure and file names do not change. The Notebook pages can be edited in Briefcase using Briefcase’s document editor. The migration preserves all the revision history, if it was available, including the revision date and user information. Shared folders are also preserved.

Note: The spreadsheet and slideshow functions are no longer available

It is highly recommended to create a backup of the mailbox before upgrading to ZCS 7.0. In a rare case when the migration has not processed all the Notebook pages in the mailbox, the old Notebook items can be retrieved from the backup and manual migration can be attempted on the backup data.

The system wiki account is no longer used. If there is active content in the mailbox of the system wiki account, log on to the wiki account after the upgrade so that the Documents Notebook pages are migrated to Briefcase, as the old Documents Notebook content shared with users will not be available in ZCS 7.0

Rebranding the Zimbra Web Client Help

The Zimbra Web Client Help can be rebranded to replace reference to Zimbra and the Zimbra product name with your company and product name. You modify the ZbMsg.properties file in /opt/zimbra/jetty/webapps/zimbra/WEB-INF/classes/messages/ to change the Zimbra names in the following variables:

- "web client long name" - ClientNameLong = <Zimbra Web Client>
- "web client short name" - ClientNameShort = <ZWC>
- "Your company name" - CompanyName = <Zimbra>
• "product full name" - CollaborationProductName =<Zimbra Collaboration Server>

• "product short name" - CollaborationProductShortName =< ZCS>

To change these variables

1. SSH to the Zimbra server

2. As zimbra, change directory to the following directory /opt/zimbra/jetty/webapps/zimbra/WEB-INF/classes/messages/

3. To change the values, edit ZbMsg.properties. Replace the Zimbra name with your company name. DO NOT CHANGE OR REMOVE THE VARIABLE DESCRIPTOR.

4. Restart the server. Type: zmcontrol restart.

5. Reload the Help in the browser.

Step 5 may require a forced browser reload or a clearing of the browser cache.

Note: When you upgrade ZCS, changes made to the ZbMsg.properties file are lost. We recommend that you make a copy of the changed file to restore after upgrades.

Updating Customized Themes in 7.0

In ZCS 7.0, the themes were updated and the logo banner sizes have changed.

If you modified ZCS themes to add your logo to the logon page, splash screen and ZWC, you will need to adjust the logo sizes to fit the new layout.

• For the company logo that displays on the login and splash screens in ZWC and ZCS administration console the dimension of the graphic must be exactly 300 x 48.

• For the small company logo in the upper-left of the ZWC application and the administration console, the dimensions the graphics must be exactly 200 x 28.

ZCO Support for Multi-Service MAPI Profiles

A Zimbra account can now been combined with POP, IMAP or Exchange accounts within a common Outlook profile. Within these profiles the Zimbra account does not have to provide the default store, although this will affect the extent to which you can use current ZCO functionality.

Outlook 2003 and Outlook 2007

With Outlook 2003 and Outlook 2007 all mail is sent from the default store. When sending a message, the Accounts button allows you to choose to send
using the Zimbra or the non-Zimbra account (or using Zimbra Personas when these have been set up). All messages are sent from the default store's Outbox and copies are placed in the default store's Sent folder. And if the default store is not in the Zimbra account then these Sent Items will not be synchronized to the Zimbra server.

All Meeting Requests are sent from the default store but will be processed correctly, provided the user ensures that a meeting in the Zimbra Calendar is sent using the correct Zimbra account.

Typically when adding a second account to an existing profile, the first account will continue to provide the default store. So if, for example, you add a ZCO account to a POP profile then the POP setup's PST will remain the default store. To change this you need to modify the profile in the Control Panel's Mail applet, selecting the Zimbra entry in the list of Data Files as the default.

**Note:** The exception to this rule is Exchange: if a profile includes an Exchange account then this must always be the default store. If you add an Exchange account to an existing profile then the default will be modified during the configuration process. If you subsequently change the default to a Zimbra account then the Exchange store will cease to function correctly. So for Outlook 2003 and Outlook 2007 this significantly restricts the ZCO functionality available when using Exchange and Zimbra accounts in a common profile (since Exchange has to be the default).

**Outlook 2010**

Outlook 2010 provides extended support for multiple stores such that, for example, accounts can use the Outbox and Sent Items of separate stores for separate accounts. As a result, messages sent using a Zimbra account will be sent from the Zimbra store's Outbox and subsequently copied (by default) to the Zimbra store's Sent Items, irrespective of which store is designated as the default.

Requests and acceptances can be sent and received for meetings in a non-default Zimbra Calendar.

**Delegates**

There are some outstanding issues with delegate functionality which have not yet been fully addressed. For the moment, for all Outlook versions, the use of the Zimbra delegate functions, Open Other User's Folder and Send On Behalf Of, cannot be supported in a profile where Zimbra does not provide the default store.

**Beta Features in ZCS 7.0**

These features included with ZCS 7.0 are considered BETA quality. These features should not be enabled in a production environment and are not supported.
• A new calendar view, Free/Busy View, can be enabled from the COS/Account Features tab. This view lets users set up a free busy schedule to track the free busy status of different people and resources in one place. (Bug 34827, 55904)

Future Changes to ZCS

This section documents major changes to future releases of ZCS.

• Extra and Experimental Zimlets in /opt/zimbra/zimlets-experimental and opt/zimbra/zimlets-extra will be removed from ZCS installation in the next major release of ZCS. Zimlets will be available from the Zimbra Gallery, http://gallery.zimbra.com. (Bug 52813)

• Zimbra Instant Messaging (IM) capabilities are going to be removed in the next major release of ZCS. These capabilities include the embedded IM server and the Zimbra IM Client (part of the Zimbra Web Client). Zimbra IM is marked BETA and should not be enabled in a production environment and is not a supported feature.

Upgrade Process

To upgrade from 5.0.x or 6.0.x to 7.0.x, download the latest ZCS 7.0.x and run the upgrade.

Before you Upgrade

The following may need to be done before you upgrade.

Zimbra Database Integrity Check

Some customers have had corrupted databases prior to upgrade, and the upgrade has in some of those cases exacerbated the problem. In order to detect any corrupted databases as early as possible, we have added an optional step to check the MySQL database with zmdbintegrityreport prior to making any system changes. You are prompted to decide if you would like to run the zmdbintegrityreport.

The zmdbintegrityreport can take minutes to an hour to run, depending on your system size and disk bandwidth.

Note: The zmdbintegrityreport is run on a weekly basis from cron on all zimbra-store nodes. Large sites can opt to disable this by setting zmlocalconfig -e zmdbintegrityreport_disabled=TRUE. If customers choose to disable this, it is recommended that the integrity reports be run by hand during the customer’s normal maintenance windows and prior to running any ZCS upgrades.
Preparing your OS

Before you upgrade ZCS, Zimbra recommends that the operating system is updated with the latest patches that have been tested with ZCS.

**Important:** If your OS is SUSE Linux Enterprise Server 11, make sure you have SP1 installed. Zimbra supports only SLES11, SP1. (Bug 52031)

Verify Certificates Expiration Date

ZCS 7.0.x requires a valid self-signed or commercial SSL certificate for communication between some components. The self-signed certificates that are automatically created by the ZCS install have a default expiration of 365 days.

If you have an ZCS installation that is over one year old and are using self-signed certificates, your certificates will need to be updated either prior to the upgrade or immediately following the upgrade.

After you upgrade, the following commands run as the zimbra user will regenerate the self-signed SSL certificates:

- `sudo zmcertmgr createca -new`
- `sudo zmcertmgr deployca`
- `sudo zmcertmgr deploycrt self -new`

License Activation for 7.0

All network edition installs now require license activation. New installs will have a 10 day grace period from the license issue date before requiring activation. For Upgrade installations, activation is automatic during the install with systems that have external access to the Zimbra license servers. We will provide a means of creating manual activations for systems that do not have external access to the Zimbra license servers. See the ZCS installation guides for more information.

When upgrading to ZCS 7.0.0 or later, the way in which ZCO and Archiving licensing is enforced has changed in the server. Older licenses may have `MAPIConnectorAccountsLimit` set to 0 or `ArchivingAccountsLimit` missing in the license, please contact sales for an updated license file prior to upgrading if you have licensed either of these features and your current license doesn’t properly reflect the correct number.

**Important:** Note that an upgrade installation will not proceed without automatic activation or a manually activated license file. Also, license activations are limited to three activations per license file. If you have previously used all three activations prior to upgrading your production system, you must contact sales to enable additional license activations.
Upgrade Instructions

Go to www.zimbra.com Network Edition Download page for the latest version of the software.

Important: Before you begin the upgrade, make sure you have a good backup for all users!

When you run the install script, if ZCS is already installed, you will be asked if you want to upgrade. Follow the instructions in this release note to perform the upgrade. For additional information, refer to the installation guide.

Single-Server Upgrade Steps

Read the release notes before you begin.

You do not need to stop the services before upgrading. The upgrade process automatically stops and starts the services as required for the upgrade.

Important: Zimbra recommends that you run a command such as the UNIX command, Immune to Hangups (nohup), so that the session does not terminate before the upgrade is completed. This is important when the upgrade includes restoring a configuration that has a large number of accounts.

1. Log in as root to the Zimbra server and cd to the directory where the Zimbra Collaboration Server Network Edition archive tar file is saved (cd /var/tmp). Type the following commands:

   `tar xzvf zcs.tgz`, to unpack the file

   `cd [zcsversionfullname]`, to change to the correct directory

   `.install.sh`, to begin the upgrade installation

   The upgrade script begins by checking for an existing installation and then checks for the Zimbra license. If the license is found, the number of current users and the number of user licenses is listed.

2. The Zimbra software agreement is displayed. Read this software license agreement and type Y.

3. The installer checks for prerequisites. If any are missing, the upgrade stops. The installer checks for a recent backup. If one is not found, Do you wish to continue without a backup? is displayed. The default is N. If you select N, you exit the upgrade. Run a backup and then restart the upgrade.

4. Next, Do you want to verify message store database integrity (Y) is displayed. The default is Yes. This step runs zmdbintegrityreport to verify that the MySQL database is not corrupt before upgrading to the latest ZCS.
The zmdbintegrityreport can take minutes to an hour to run, depending on your system size and disk bandwidth. It is preferable that you run zmdbintegrityreport at the time of the ZCS upgrade. If you choose to skip this now, the zmdbintegrityreport will run during a regular scheduled interval after the upgrade is finished.

5. When Do you wish to upgrade? [Y] is displayed, press Enter to continue. The upgrade packages are unpacked.

6. The packages are listed. The installer also lists packages that are not installed. If you want to install the packages at this time, type Y; otherwise press Enter. The upgrade checks that there is enough space to perform the upgrade. If there is not enough space, the upgrade stops.

7. When The system will be modified. Continue? [N] is displayed, type Y and press Enter. The Zimbra server is stopped, and the older packages are removed. The upgrade process verifies which version of ZCS is being run and proceeds to upgrade the services, restores the existing configuration files, and restarts the server. If you have a configuration with a large number of accounts created, this can take a while.

8. If you have not set the time zone, you will be asked to set it. This sets the time zone in the default COS. The time zone that should be entered is the time zone that the majority of users in the COS will be located in.

9. When Configuration complete – press return to exit displays, press Enter. The upgrade is complete

Multi-Server Environment Upgrade Steps

Before you begin, stop all the servers in your ZCS environment. To do this, on each server, as zimbra type zmcontrol stop.

Important: Upgrade the servers in the following order: LDAP server, MTA server, and then mail store server. The LDAP master server should be running as you upgrade the other servers.

1. Log in as root to the Zimbra server and cd to the directory where the Zimbra Collaboration Server upgrade archive tar file is saved (cd /var/tmp). Type the following commands:
   tar xzvf zcs.tgz, to unpack the file
   cd [zcsversionfullname], to change to the correct directory
   ./install.sh, to begin the upgrade installation
   The upgrade script begins by checking for an existing installation.

2. The Zimbra software agreement is displayed. Read this software license agreement and enter Y.

3. The installer checks for prerequisites. If any are missing, the upgrade stops.
Mail store server - The installer checks for a recent backup. If one is not found, **Do you wish to continue without a backup?** is displayed. The default is N. If you select N, you exit the upgrade. Run a backup and then restart the upgrade.

4. When you upgrade the mail store server, the installer displays **Do you want to verify message store database integrity (Y)** is displayed. The default is Yes. This step runs `zmdbintegrityreport` to verify that the MySQL® database is not corrupt before upgrading to the latest ZCS.

Running `zmdbintegrityreport` can take minutes to an hour to run, depending on your system size and disk bandwidth. It is preferable that you run `zmdbintegrityreport` at the time of the ZCS upgrade. If you choose to skip this now, the `zmdbintegrityreport` will run during a regular scheduled interval after the upgrade is finished.

When the mySQL software versions are changed during upgrades, the underlying database tables need to be upgraded. The `zmdbintegrityreport` does this automatically during it’s first run and will report the changes. These are normal and should not cause alarm when upgrading.

5. When **Do you wish to upgrade? [Y]** is displayed, press Enter to continue. The upgrade packages are unpacked.

6. The packages you want to install on the server should be marked Y. All other packages should be marked N.

   The upgrade checks that there is enough space to perform the upgrade. If there is not enough space, the upgrade stops.

7. When **The system will be modified. Continue?** is displayed, type Y and press Enter. The server is stopped and the older packages are removed. The upgrade process verifies which version of ZCS is being run and proceeds to upgrade the services, restores the existing configuration files, and restarts the system. If you have a configuration with a large number of accounts created, this can take a while.

   **Note:** When upgrading the zimbra mail store, the upgrade checks for the Zimbra license. If the license is found it lists the number of current users and the number of user licenses. If it is not found, press Enter to continue. You can add the license later from the administrator’s console.

8. When **Configuration complete – press return to exit** displays, press Enter. The upgrade is complete. Continue to upgrade each server.

### After the Upgrade is complete

After you completed the upgrade to 7.0, the following bullet items may need to be addressed.

- MySQL table upgrade is required after upgrading to ZCS 7.0. MySQL table upgrades are not automatically run during the upgrade to 7.0 based on time that it takes this process to run. There are no known performance impacts
of running in production without doing this MySQL table upgrade. Customers can avoid these errors in the zmdbintegrityreport output by executing `/opt/zimbra/libexec/scripts/migrate20100913-Mysql51.pl` For a 4000 mailbox, 250 MB mailbox size, the script could take about 70 minutes to run. Customers should schedule their maintenance window accordingly. (Bug 24329, 50557)

- If your self-signed SSL certificates have expired, update them. See Verify Certificates Expiration Date on page 19.

- If your pam configuration rules disallow null passwords, you will need to define a password for the zimbra UNIX account after the upgrade. This will allow ssh key authentication for checking remote queues. (Bug 12807)

**Upgrading new 7.0 Features**

- If you want users to access the following new or beta features, these features must be enabled after the upgrade.

  The following can be enabled from the administration console Features tab:

  - Ability to let users recover deleted items. Enable Dumpster folder (Bug 30582, 45284)
  - Ability to send mail at a later time. Enable Mail send later. (Bug 7524, 51673)

**Removing current version and performing a clean install for ZCS**

If you do not want to upgrade, but prefer to install ZCS Network Edition as a new installation, when you run the ZCS Network Edition install script, enter **N** (no) when asked “Do you wish to upgrade?”

A warning displays asking if you want to delete all existing users and mail. If you enter Yes, all users, mail, and previous files are removed before proceeding with the new installation. Refer to the installation guides for installation instructions.

**Status of Your Customizations to ZCS after Upgrade**

Upgrading to the newest release does not delete your accounts or change your configuration.

Configuration settings stored in LDAP and localconfig are preserved during upgrades. Any files installed by ZCS may be deprecated and/or overwritten during upgrades, removing any customizations. This includes customized themes, logo branding changes, crontab changes.

Zimlets that you customized and deployed are preserved during the upgrade. As upgrading of customized Zimlets can not be tested before the release, Zimbra recommends that you verify that your customized Zimlets work correctly after the upgrade.
All entries between the designated comments in the Zimbra crontab file are overwritten with new defaults upon upgrade. Customized backup schedules stored in the Zimbra crontab and customizations to the crontab entry outside the designated comments are preserved.

Known Issues

Zimbra engineering has identified a number of issues with the software, and we are actively working to resolve them. Following are the issues that are most likely to occur. All known bugs are listed in Zimbra’s Bugzilla database, available on the Zimbra web site, at www.zimbra.com.

General Known Issues

<table>
<thead>
<tr>
<th>Issue #</th>
<th>Summary</th>
</tr>
</thead>
</table>
|         | Known third-party browser issues  
Some browser issues can affect how the Zimbra administration console and Zimbra Web Client work.  
When you get a browser error, try reloading the browser to continue.  
• If you use the Firefox browser, the cursor position may not be visible in the text boxes, and you have no visual feedback to continue to enter text. Even though you cannot see the cursor, type in the boxes as normal.  
• If mail is displayed in HTML format, you cannot select the text with the mouse. |
| 56939   | When upgrading to ZCS 7.0.0 or later, the way in which ZCO and Archiving licensing is enforced has changed in the server. Older licenses may have MAPIConnectorAccountsLimit set to 0 or ArchivingAccountsLimit missing in the license, please contact sales for an updated license file prior to upgrading if you have licensed either of these features and your current license doesn’t properly reflect the correct number. Use zmlicense -p to view your license information. |
| 51775   | ZCO with Outlook 2003. Work around - To add, modify or delete signatures using Outlook 2003, use Tools->Options->Mail Format tab and the associated Signatures button.  
(If you have configured Word to be your email editor, using the Tools->Options->Mail Format tab->"Use Microsoft Word 2003..." checkboxes, you will see a small drop-down arrow next to the Options button in the window you use to compose a new e-mail. This also allows you to edit signatures, but changes made here will not be synced to the server, and may be lost after restarting Outlook) |
Customers currently on ZCS 6.0.8 and using a non-default password change listener should make sure that the zimbraPasswordChangeListener attribute is set up correctly at the domain level, before upgrading to ZCS 7.0.

To check the value of the attribute, run

```bash
$ zmprov gd YOUR_DOMAIN zimbraPasswordChangeListener
```

To change the value, say, to the samba password listener, run

```bash
$ zmprov md YOUR_DOMAIN zimbraPasswordChangeListener sambapassword
```

Calendar Week Numbers displayed in the mini-calendar are wrong when the Calendar preferences for **Start week on** is set to Monday.

If the Short Cut Trainer Zimlet is enabled, when a message is deleted a script error is displayed. To avoid this, disable this Zimlet. This is not a supported Zimlet.

Third-party issue. Windows Mobile 6 removes all occurrences of a recurring meeting when the first instance is deleted.

Third-party issue. Android SDK 2.2 cannot display inline image content.

**FIXED IN 7.0.1 -**

ZCO. (Wontfix) When ZCO is upgraded, if users re prompted that a dll is in use by searchprotocolhost.exe., they should click the Continue button to proceed with the upgrade.

Family Mailbox is not supported in ZCS 7.0

ZCO/BES (WontFix). BES adds the appointment to the Calendar.

VMware does not support Red Hat Cluster Suite on ESX/ESXi.

A forwarded recurring appointment instance will not update the organizer’s attendee list. Therefore, if the organizer modifies the appointment, the user with the forwarded appointment will not get updated.

After activating or updating a license, the administrator can run

```bash
zmprov fc -a license
```

to immediately flush the license cache on all mailbox nodes.

Third-party issue. Android devices cannot display .eml attachments. When forwarding a message on an Android device using mobile sync, the server will include the original message as an .eml attachment. Workarounds is to reply instead of forward until the device issue has been addressed.

Third-party issue. iPhone calendar may not sync correctly when declining or accepting an appointment in ZWC after the appointment has already been accepted/declined from iPhone.
Product Documentation

Online help and ZCS documents are available on the administration console. Documentation can also be found on the Zimbra web site in pdf, and the Zimbra wiki has articles that the support team and the community have written in response to troubleshooting and administration issues.

Bug Reporting

If you encounter problems with this software, go to http://bugzilla.zimbra.com to submit a bug report. Make sure to provide enough detail so that the bug can be easily duplicated. Also, to discuss issues and this software in general, please visit our community forums at http://www.zimbra.com/forums.

-----------------------------------------------------------------------------------------------

Copyright © 2011 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and intellectual property laws. VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents.

VMware and Zimbra are registered trademarks or trademarks of VMware, Inc. in the United States and/or other jurisdiction. All other marks and names mentioned herein may be trademarks of their respective companies.

ZCS 7.0
GA February 2011
ZCS 7.0.1 3/7/11
Rev April 20, 2011